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DESIGNING AND MAKING A PHOTO BOOK BY MICHAEL SMYTH 
 

Creating a photo book can be a great way to share and preserve your valuable photographs.  There are 

a number of things you need to consider before making your photo book and, in this tutorial, we go 

through these in detail, plus we provide a step by step method to ensure your photo book is printed at the 

best quality possible.  In preparing this tutorial I have assumed users are familiar with both Lightroom and 

Photoshop. 

 

THINGS YOU NEED TO CONSIDER BEFORE YOU START YOUR PHOTO BOOK: 

 

1.  DECIDE WHO THE BOOK IS FOR: 

Before you start anything, you need to decide who the book is to be for – is it for your own use as a 

record of your images, a gift for family members, or even perhaps for sale to the public? 

 

Knowing how your book will be used will help you decide on important things like design, content, titles 

and descriptions.  Choose a title for you book that reflects its purpose and content. 

 

There are many different types of books:  Travelogue, family memories, or a special function (wedding?), 

Personal portfolio, storytelling, artistic or personal project.  Each requires a slightly different approach and 

design, so before you start, be clear about who your book is for and how it is intended to be used. 

 

2.  CHOOSE THE SIZE AND ORIENTATION, PAPER AND STYLE 

Photo books can be landscape, portrait or square, decide what works best for your project.  Typically, 

most photo books are landscape, but if your images are mostly portrait orientation, or square, consider 

one of the other options. 

 

There are also options for the type of binding (also depending on the number of pages), paper stock, 

cover design and type of cover, etc., Some of these options come at a premium price, so choose 

carefully.  Decide how many pages you are going to use for the book.  Don’t make it too big.  

Remember, each “page” is really a face, so a 60 page book has 30 “sheets”, 2 sided.  Allow for blank 

and title pages where necessary.  It is important to know roughly how many images you need for your 

book when you start to curate and cull selections. 

 
Note:  One last thing to consider: printing using a book printer can never match the quality you can 

produce using a high end inkjet printer.  Inkjet printers give the best quality that money can buy, and a 

photo book will not match this quality, but of course you are getting a book at a much cheaper price 

than printing it yourself, not to mention the binding and finishing.  Using our step by step guide will enable 

you to get the best possible result from the book printing service.  
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Above:  Why book printers can’t match the quality of inkjet prints.  At left the plan view of the colour 

gamut a high quality inkjet paper (translucent outline) and a typical book paper stock.  At right the side 

view of the colour gamut showing that inkjet paper can print dense black, but the book stock can’t, plus 

the inkjet paper has a much larger colour gamut overall.  On the right the Lightness axis is shown 

vertically, the left image only shows a plan view of the a and B axes of the L*a*b colour model. 

 

Once you have decided on the purpose and overall design of the book, you can start to think about the 

design and content.  All book printing services provide software for preparing the book layout, but these 

are mostly fairly basic and have some pitfalls.  More on this later. 

 

The preferred method of preparation of your book is to use Lightroom and Photoshop to prepare the 

images and lay out the pages.  See the step by step methodology at the end of this section for a 

foolproof way to step through the process. 

 

3.  BOOK DESIGN 

In thinking about how you are going to lay out your images, there are plenty of websites that offer design 

and layout ideas, and we won’t go into these here.  This tutorial is aimed at helping you get the best 

possible quality with the least chance of making a mistake or falling into any of the many traps that await 

the unwary. 

 

Look at the online services that offer design ideas, there are plenty available, some good, some less so.  

The most important consideration in making a photo book is to let the photos do the talking, don’t over 

complicate things with messy backgrounds or too many images crammed onto each page.  The 

fundamental principle is “less is more”. 
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Generally, for your most important photos, allow one per page, don’t fall into the trap of running an 

image across the binding, in 99% of cases it doesn’t work, and you lose part of the image in the spine.  

Most photographers hate this, so only use it if absolutely necessary. 

 

Use the images to tell a narrative or follow a theme.  Images should be complimentary on opposing 

pages.   

 

Don’t use too much text and avoid adding technical information – shutter speed, aperture and ISO etc.  

This isn’t useful or necessary (some photographers put all this information on each photo, but it really isn’t 

of any use to the viewer, except in some unusual circumstances).  Keep titles brief – the photo will usually 

tell the story.  If there is an explanation or context behind the image, consider providing an index at the 

back with more details (and the technical information if you really can’t resist!). 

 

When laying out and sizing your photos, leave some space around them to “breathe” and act as a 

frame. Only use full bleed images occasionally (where the photo fills the entire page with no border)– for 

some special shots, not all the time. 

 

 

Above:  A maximum of 4 images per page, as long as they fit a theme.  
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Above:  Two page options with “Breathing” space for the photos, don’t cram too many onto the page, 

allow 1 image per page for the most important pictures, leave space around others. 

 

4.  CURATE YOUR IMAGES AND CULL BEFORE YOU START PROCESSING 

Usually, you will have way too many photos for your book.  Having too many to choose from will drive you 

crazy, so use our step by step guide to make it easy on yourself. 

 

Essentially, you don’t want too many photos that are similar, so try to select the best or most appropriate 

ones and leave the others aside.  If telling a story, try to make sure that the images will have a flow and 

not have gaps or confusing changes of theme or viewpoint. 

 

5.  KNOW THE BOOK PRINTING REQUIREMENTS BEFORE PUTTING IT TOGETHER 

Before preparing the final pages, you need to know the following in order to be sure that the book will 

look as good as possible: 

 

What DPI are the images/pages printed at? (Using the book maker’s software, the pages are resized 

automatically, but this may not be “optimal”) i.e., you don’t have any control over how this is done.  

 

Does the book printer provide an ICC profile for colour matching on your screen?  (Without an accurate 

representation of the paper colour and gamut you are only guessing at how the images will look). 

 

What colour space is required for the book printing hardware?  Usually this is sRGB (which is really a 

display colour space), but you should know what they want as it is best to prepare the book images in 

this colour space first.  Converting the image “behind the scenes” inside the bookmaking software may 

not give the desired result and you can’t preview the look before it goes to the printer. 

 

Should the images be sharpened for output on the printer? (Inkjet printers require specific sharpening to 

counteract the slight softening of the image when ink is squirted onto paper).  What output sharpening is 

optimal for the printer hardware?  Book printers say that no sharpening is needed, but the finished images 

are often a little soft.  
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6.  PUTTING THE BOOK TOGETHER - THE MOST EFFECTIVE WAY IS TO MAKE THE PAGES IN PHOTOSHOP 

For best control over the final quality of the book, we recommend making each page in Photoshop, 

using a template at the actual paper size and printer DPI, with the correct colour space applied.  This 

should mean that WYSIWYG (What You See Is What You Get) applies to the result.  Ensure you are working 

on a calibrated monitor that is set to 80 Candelas brightness so you can assess the brightness of the 

image on paper. (80 Candelas is the recommended brightness level to simulate paper brightness). 

 

When preparing the images for printing, use the ICC Profile (if available) for the paper the printer is using.  

This gives the most accurate representation of the end result.  If no profile is available, ask for it try using a 

colour temperature of 5000 Kelvin and sRGB colour space at 80 Candelas. 

 

Making the pages in Photoshop might seem like overkill, but the bookmaking software is usually fairly 

limited in functionality, and you really can’t get accurate control over the layout.  Doing it all in 

Photoshop and then adding each page to the bookmaking software at 100% ensures accurate sizing, 

layout and reproduction. 

 

Making a template (or series of templates) in Photoshop allows you to accurately set margins, edit text 

size, spelling (so very important) and positioning.  You can also assess the final look of the image and text 

together on the page.  If using a standardised layout for your book, making a template with guides will 

make it easy.  You will need to save the pages in a format acceptable to the bookmaker’s software.  

Typically, this would be JPEG, TIFF or PNG (Portable Network Graphics) format.  Generally, PNG is 

preferred over JPEG as it is a lossless compression format that does not have the issues associated with 

JPEG compression.  Check the bookmaking software to see what is preferred. 

 

Above:  A page template created in Photoshop.  Note the guides and text layers. 
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Using Photoshop to add the text to pages allows you to use special characters, as well as adjusting the 

spacing of letters on title pages.  For the Iceland book I needed special Icelandic characters for some of 

the titles that may not be possible within the bookmaking software.  For the title page, I needed special 

spacing for the individual letters of “ICELAND”, and this is done in Photoshop using the Character tools.  

You can also do some tricky things with Letter transparency, Stroked edges and drop shadows that won’t 

be possible with the bookmaking software. 

 

Above:  A book cover with text transparency and drop shadow – only possible in Photoshop. 

 

As you complete each page, save them in the book format (JPEG, PNG or TIFF) and name them “page 

1, page 2” etc.  Save each completed page in a new location – it is best to set up a new folder on your 

hard drive called something like “Iceland book pages” this keeps the completed pages separate from 

your selections and source images.  Import this folder into Lightroom and place the pages into the book 

module.  If you have titled your pages correctly, you should be able to use the automatic layout to add 

all the pages in order into the book.  Otherwise just add the pages one by one to preview the overall 

effect of the book. 
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Left:  A title page with custom 

text spacing, sizes and 

alignments, easy to do in 

Photoshop but tricky to 

accomplish in book layout 

software. 

 

 

 

 

 

 

 

 

Make a separate page for the front cover, back cover and title page.  I also made index pages at the 

back of the book with thumbnails of each image and a more detailed description of the image.  Add 

these to the book layout and make sure that facing pages have the correct margins and look “right”. 

 

 

Above:  An index page with details and a story about each image.  This helps to keep the main image 

pages free of clutter. 
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Once you have the pages prepared and images processed, you can output a draft as a PDF from 

Lightroom.  Make sure you add the pages you have created into the Lightroom book module and then 

choose “Export Book to PDF”.  This will allow you to make a final check of each page.  Be extra careful to 

double check the spelling and text layout for each page.  Spelling errors are a common problem with 

most books, and it pays to be extra careful in checking every word. 

 

 

Above:  The book layout in Lightroom is used to check the arrangement of pages and margins. 

 

Finally, when you are completely satisfied with the draft, go to the bookmaker’s software and add your 

prepared pages.  Make sure they are in the correct order and are at 100% scaling.  If the pages are 

scaled up or down, some softening will be applied to your images that will result in a loss of quality. 

 

When done, you can use the book maker’s software to upload the book.  This will entail the software 

compressing and uploading the pages to their server.  You may have the option of viewing a preview of 

the book once uploaded, so it is a good idea to do a double check, although it is not clear if this gives 

an accurate representation of the final result (colours and sharpness). 

 

For a step by step methodology, see the following section. 

 

  



9 
 

 

 

PUTTING YOUR BOOK TOGETHER – STEP BY STEP FROM BEGINNING TO END 

Using this step by step method to prepare your images and book pages, you will retain the best quality 

possible in your images and ensure the colours are correctly handled during printing. 

 

A: First, set up a Collection Set in Lightroom, this will contain collections that will be used for the different 

parts of the book.  If you are only working with one series or theme, just make one collection within the 

Collection Set called “Shortlist” or something that will tell you that this collection contains all the images 

you are considering for inclusion.  If working with several themes or groups, make a Collection with a 

name for each group, all within the Collection Set. 

Left:  The Collection Set in 

Lightroom.  Create 

Collections within this set 

for each book section, if 

needed.  Add a 

Collection called “Final 

Selection” for your 

shortlisted images. 

 

 

 

 

 

B: Inside the Collection Set create another collection called “Final Selection”, which will be the images 

you have decided to use from the “Shortlist” of your images.  This makes it easier to curate and cull 

images.  Making the final selection of images is the hardest part of the bookmaking process, so breaking 

down the book into sections can make this process easier. 

 

C: Select images to add to each collection and drag them into the appropriate collection.  Moving 

through your image folders you can now select images that you want to consider for your “Shortlist”.  As 

you choose each image, drag and drop the thumbnail (either from the grid view or the filmstrip) in the 

Library Module into the appropriate collection.  This adds the images to the collection, BUT DOES NOT 

duplicate them, this acts like shopping list of items.  The original image is always in the library folder, the 

collection is merely an external reference to the image locations.  This is important to remember as the 

image only exists in one place.  Deleting an image (culling) from a collection DOES NOT delete it from the 

library. 

The images you add to your “shortlist” may come from different folders within Lightroom, so putting them 

together in the one place helps when considering which to include in the final selection. 
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D: Try moving images around in the collection to get an idea of the flow you want for the book.  Often 

images will naturally fit together as part of a narrative, or as complimentary images that convey your 

story.  You can also see pretty quickly if you have similar images and can compare and then delete the 

ones that you don’t want to use.  Remember:  deleting from a collection does not remove them from 

Lightroom, only from the collection. 

 

E: Carefully assess each image you have added to the collections and discard ones that are too similar, 

or don’t fit the narrative.  Be ruthless.  Select images from each collection and then right mouse click and 

choose “Remove from Collection”.  You may need to go through this process several times to get the 

numbers down to the approximate number you need for the book.  Knowing how many pages you are 

using and whether there will be multiple images per page gives you a rough number to work towards. 

 

F: Don’t waste time processing images at this stage (although a quick series of adjustments might be 

helpful – use Lightroom’s Quick Develop tools in the Library Module) If you spend time processing images 

that ultimately are discarded, you will waste a lot of time.  Wait until you have culled the collection and 

moved the final images into the “Final Selection” before doing any serious processing. 

Making a few quick adjustments from within the Library Module can assist is seeing if an image is worthy 

of more time spent on fully processing the file and help you decide to cull or keep it. 

 

G: Once you have culled the images in each collection, drag the selected ones into the Collection 

called “Final Selection”.  From now on, all work will be centred on this collection.  Note:  the images in the 

other collections within the Collection Set will remain, they will be added to the “Final Selection” 

Collection and remain in the other collections. 

 

Above:  A collection is used to select images for the “Final Selection” Collection.  Dragging from one 

collection to another puts it in both collections (but it only really exists in the original folder). 
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H: Once you are happy with the number of images, go ahead and process your images, ready for 

inclusion in the book.  At this stage treat them the same way you would with any other image, i.e., keep 

them in 16 bit ProPhoto RGB colour space and keep layers, if wanted.   Make initial adjustments in 

Lightroom and finalise the images in Photoshop as if you were going to print them yourself.  Save the 

completed files as either TIFF or PSD (Photoshop format) files.   

 

Important:  When working on processing an image contained in a Collection, PROVIDED you save the 

finished file in the same source folder, the completed file will also appear in the Collection.  This only 

works if you select the image in the collection (remembering that it only exists in one location) and 

process it in the Develop Module, then into Photoshop.  Saving from Photoshop takes you to the source 

folder to save the PSD or TIFF file.  The processed file will then appear in the collection alongside the 

source RAW file.  (After processing you can remove the source RAW file from the collection). 

 

I recommend giving each completed image a unique name with the original file number at the end.  

That way you can always find the original RAW file again if you decide to reprocess the source file.  Once 

you have edited and saved each file, compare it to the source RAW file to make sure you are satisfied 

with the result.  Also compare them with other files that will appear on opposing pages or adjacent in the 

book, to ensure a consistent “look”, especially with images from the same or similar location.  Once 

satisfied, remove the RAW file from the Collection (it will still be in the “Shortlist” collection). 

 

H: Once the images have been processed, use the book module in Lightroom to lay out the pages.  This is 

a handy way to work out the layout and flow for your book as all the images reside in the same location.  

Make sure you are still working in the “Final Selection” collection.  This will allow you to quickly move 

images around and establish an order as well as give you a sense of how the facing pages will look.  Add 

in blank and title pages where necessary.  We are not going to use Lightroom’s default book printer 

(Blurb), this is just an easy way to get a visual guide on how the book will look before you go into the book 

printer’s software. 

Remember, when laying out the pages, you lose a bit on the side that is bound, so you need to allow for 

this in preparing the final layout.  See the template section below. 

You should now be pretty happy with how the book will look.  Where you have multiple images on a 

page you can see how they look against the other pages, and you will see if you have the correct 

number of pages. 

 

I:  Prepare templates in Photoshop for the pages.  You will need both a Left Hand and a Right Hand page 

as you need to leave room for the binding.  Set up the page at the full size of the book you are printing, 

such as A4 (The Blurb book module annoyingly does not use metric paper sizes, but it is only for layout 

purposes anyway).  Use Guides to establish top, bottom and Left and Right margins.  For a Left hand 

page, the binding will be on the right, so allow a larger margin – say 28-30mm to allow for the binding.  
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The other margins can be much smaller, bearing in mind if you are using a full bleed image (no borders) 

the image will need to cover all of the page. 

 

Save the template pages in a new folder within your image file location and call this “My Book Pages” 

For example “Iceland Book Pages”.  You can set up the templates with text layers at the size and position 

you want for consistency and amend these as you create each page.  You will need to make a 

template for the front and back covers, plus title pages and index pages, if required. 

 

Above:  A page template in Photoshop.  Note the template is the full size of the paper – in this case A4, 

with Guides used to set the margins.  This is a Left Hand page with a larger margin on the right to allow for 

binding.  The page should also be at the DPI required by the book.  

 

Make sure you have saved the template at the correct DPI the printer requires and in the nominated 

colour space (most printers want sRGB or AdobeRGB as the gamut of the printers used does not have the 

same gamut as our inkjet printers).  The template files should be initially saved as a TIFF or PSD file to allow 

editing.  Some Book printers provide templates – Momento Pro have templates available in PSD format to 

assist you in getting this right.  In setting up the templates, allow for the margins and the gutter space 

(edge where the binding takes place) by setting up Guides and saving them with the templates. 

 

The gutter margin will differ depending on whether your book is side sewn (most common) section sewn, 

lay flat or softcover.  See your book printer’s website for more information.   
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Typical margins would be:  Top, bottom, and free edge – 5 – 10mm 

Gutter margins:  Side Sewn and section sewn – 15mm to 30mm (a larger margin is preferable)  

   Lay flat – 10mm 

 

I: Prepare title and index pages and anything else that does not contain images.  Using Photoshop, you 

have a lot of control over fonts, spacing, styles, transparency and text effects.  Use these for the title 

pages and a simple clear font for the titles for each image.  Save these pages initially as TIFF OR PSD files 

to allow final editing, if necessary.  If you want to use special features such as filled text, special spacing 

and special characters, you can really only do this in Photoshop.  When you have finished setting up the 

title and cover pages, save these into the book pages folder in the required file format for the book – 

either JPEG, TIFF or PNG.   

 

J. Prepare each page by adding the images to the prepared template.  The template must be the actual 

page size, DPI and colour space as required by the printer.  Before adding the images to the template, 

open each one, flatten all layers, then size to fit the page in mm and at the DPI of the page.  This is 

important to keep the sharpness and quality of the image in the page layout. 

 

Open your processed image, then go to Layer>Flatten Image 

Next, go to Image>Image Size and enter the width or height you want for the image AND set the PPI to 

the printer requirements (usually 300 PPI).  Choose “Bicubic Sharper” as the resampling method if 

reducing the image size, or “Preserve Details” for enlargement (you shouldn’t be enlarging files!) 

 

Above:  Resizing the image prior to adding to the template.  The size is determined by the margins set on 

the template.  Resolution is set to the book printer’s requirements, usually 300 PPI. 
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Then go to Edit>Convert to Profile and convert the image colour space to the printer colour space (sRGB 

or Adobe RGB).  After converting, carefully check the image to ensure the colour conversion is 

satisfactory.  Never use “Assign Profile”. 

 

Above:  Converting to the printer colour space, from ProPhoto RGB to Adobe RGB or sRGB. 

 

Note:  you can just drag images onto the template and resize once in place, but this reduces the 

sharpness of the file.  There is a definite difference in quality to be gained by resizing the image BEFORE 

dragging it onto the template.  The difference is small, but every time you degrade the image, the 

effects are cumulative, so the resulting printed image may be a lot less sharp than your carefully 

processed original. 

 

With the image added to the template, add any text for titles and then save the page as the page 

number for your book, in the file format required, JPEG, TIFF or PNG.  Note that both JPEG and PNG do 

not support layers and once ready for the book layout, you should flatten any TIFF Files.  JPEG is a lossy 

format, so some quality degradation is possible.  PNG is a non-lossy format and is the preferred option, 

along with TIFF. 

 

Repeat this process and save each page, using the book layout in Lightroom as your guide.  Make sure 

you also make pages for the front and back covers, where appropriate.  Label these as Front Cover and 

Back Cover, Title Page Etc. 
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K:  At this stage you can soft proof your pages using the book printer’s ICC profile, if available.  The only 

printer that provides profiles by default is Momento, so if your selected printer does not provide a profile, 

ask them for it, or ask where you can download it. 

 

To Soft Proof your completed page, you can only do this in Photoshop, the soft proofing option in 

Lightroom does not seem to recognise all profiles, nor does the print Preview window in Photoshop (even 

though they both read the colour profiles from your operating system, go figure).  If you need to 

download the profile from the book printer or the ICC website, it will be saved in your “Downloads” 

folder.   

 

To install on Windows, select the profile (it will have a suffix “. icc” and right mouse click on it and choose 

“Install Profile” Windows does all this for you. 

 

To install on a Mac, you need to locate the profile in your downloads folder, then copy it and go to 

Library/ColorSync/Profiles in your Home folder and paste it into the folder.  You may need to modify 

permissions to make it work, there are websites that will step you through, if necessary. 

 

To be able to see these profiles once installed, you need to quit Photoshop and then restart it to allow 

Photoshop to read the colour profiles from the operating system. 

 

With your completed page open, go to View>Proof Setup>Custom and select as follows: 

 

Click on “Device to Simulate” and scroll through to the paper profile needed.  Here we have used 

“Fogra39” which is the profile for Photo Books Express paper. 

 

Above:  The Custom Proof menu in Photoshop.  Make sure to select “Relative Colorimetric” as the 

rendering intent and tick “Black Point Compensation” and “Simulate Paper Colour” 

 

With the setting selected, click on and off the Preview box to see a simulation of how the image will look. 
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There are a couple of Caveats with soft proofing:  It is only a simulation.  Soft proofing can’t simulate 

paper texture and surface (gloss, satin or matt), so it is a guide only. 

 

With soft proofing turned on, you will see that the deep blacks in your image will have gone to a dark 

grey.  This is because the paper used cannot hold a deep black.  There is no point in darkening the 

image or “Crunching” the blacks to compensate, it won’t make any difference, the paper can’t render 

these deep blacks.  (See the 3D colour graph of the profile on page 2). 

 

What you can do to compensate for this overall contrast loss, is to add a curves layer that adds more 

contrast to the image.  Because the printer can only print say, levels 20 – 240 instead of 0 -255 (in 8 bit 

parlance) the overall contrast is reduced.  Adding more contrast will help to reduce the visual effect of 

the paper gamut reduction (although it can’t put back what is “lost”). 

 

Left:  Using Photoshop’s preset for a “Medium Contrast” 

curve is a good starting point for adding some contrast after 

Soft Proofing, although you will probably have to adjust it to 

suit your image. 

 

Note that adding contrast also increases saturation and this 

can’t compensate for the reduced gamut of the paper.  

There is nothing we can do to increase saturation if the 

paper can’t render the highly saturated colours, although 

the printed result should be acceptable as long as you are 

not printing highly saturated images. 

 

Increasing the contrast does go some way to offsetting the 

reduced gamut of the paper and should give a satisfactory 

result. 

 

 

Once you have soft proofed your pages and made any adjustments, you will need to resave the 

amended pages, before going any further.  Note that you will need to flatten any layers if saving as a 

TIFF, JPEG and PNG will automatically flatten all layers when saved. 
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K: When you have completed and saved each page into the new folder for your book pages, you can 

then import this folder into Lightroom (use “Add to your Catalogue” only, as the files already exist on your 

system).  This folder will contain all of the completed pages in JPEG, PNG or TIFF format, plus your 

templates in PSD or TIFF format.  With this folder selected, go to the Book module and add them to the 

book layout.  You will need to add pages to the default setup and select the approximate size of the 

book – “Standard Landscape” is a good choice.  Do not add in the template pages, only the completed 

ones, which should be numbered correctly as you saved them. 

 

If you have numbered your pages as you go, the Auto layout option may work, otherwise drag and drop 

each page, including the title pages, covers and index pages onto the book. 

 

Above:  The final book layout in Lightroom using the actual pages you have created.  Now you can 

check for the layout, page handing and other errors.  Use “Export Book to PDF” to create a final proof 

that can be enlarged to check details. 

 

L: Proof your book pages and layout before committing to print.  It is really, really important to carefully 

check each page for layout, order and especially spelling and grammar, BEFORE you send it off to be 

printed.  Once it has been uploaded to the book printer, you can’t change anything, so it pays to 

double and triple check everything here first.  This is probably the most important part of the process, it is 

easy to become lazy and skip over the proofing stage, but you will forever regret not doing this is you 

later find errors in the layout or text and your family and friends will delight in pointing these out. 
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Having exported the pages as a PDF, view them is a 2 up layout to see how opposing pages will look 

together.  You can also use the book layout in Lightroom to view pages two up, as they would be in the 

book. 

Once you are happy with the checking and have made and re saved any altered pages (that’s why we 

keep the template layouts ready, in case we need to redo anything). We are ready to add the pages to 

the book printer’s software. 

 

 

Above:  Another view of the book layout in Lightroom, using the 2 page view.  The Blurb layouts do not 

allow for metric page sizes, so margins will differ a little. 

 

M: Add the finished pages into the book printer’s software.  Here it is critically important to ensure that 

your pages are scaled at 100%, to avoid any losses from resampling.  We have taken care at each step 

to maintain quality, so don’t fall at the last hurdle! 

 

Open the book printer’s software and create a new book or new project.  Make sure you choose the 

correct book size and type, based on your original selection. 

 

Using the book software, navigate to the location of your finished book pages and drag each page into 

the book layout.  Ensure the scaling is maintained and check that the pages fit within the page guides.  If 

you have made your pages the correct size, everything should be OK.  Check that you have left blank 

pages where needed and that everything matches the layout you made in Lightroom’s book module. 
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When adding your pages onto the book printer’s layout pages, if you have made your pages to the 

paper size, the pages you add should fill the page in the software. 

 

 

Above:  A book layout using Momento’s book design software.  Scale each page to fill the book page to 

ensure 100% scaling.  Alternatively set up your page templates to fit the “safe” printing area and snap to 

the guides (you will need to adjust your margins in the templates to suit the margins already included).  

 

Most book layout software is pretty similar, but you need to use the software provided by your selected 

printer in order to upload it to their servers. 

 

N: Do a final check of the layout and then you are ready to upload the book and commit to print.  You 

will need to pay for your book unless you have purchased a voucher.  During the upload process the 

software will do an error check and advise if there are any issues.  Usually this will be where you have 

deliberately left a page blank or have missed something.  After checking this all once again, you’re 

good to go! 

 

If you follow this system, you should receive your book and not get any nasty surprises and your book will 

look the way you planned it to be. 
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Here is a list of recommended book printers in Australia: 

 

Momento – high quality with options, but can be costly, provides ICC Profiles and good background 

information designed to help you get the best out of your book. 

 

Momento Pro – The professional service for enthusiasts.  They provide the ultimate quality and options for 

paper, covers and binding.  ICC profiles available and the best quality possible, but at a premium price.  

Members of photographic clubs in Australia can join with discounts.  Serious professionals use Momento 

Pro for their special books. 

 

Photobooks Express – good quality and value for money.  No choice of paper types (only different 

weights) but there are choices of mounting and covers.  Quality is good overall, but not quite up to the 

standard of Momento Pro, but at a lower cost.  A soft proofing ICC profile can be provided upon request, 

or you can download the specified profile from the ICC website.  Search for Coated Fogra 39L ICC 

profile in your search engine.  

 

Note:  Blurb is the default book publisher for Lightroom, but as they are based in the USA there is a 

consideration of time and cost, including exchange rates.  They are claimed to provide a good quality 

result (from other associates who have used them, but I have no personal experience). 

 

There are many other providers with similar options based in Australia, but we have no experience with 

them at this stage.  Each book printer provides software for laying out the book and these are all very 

similar, do a fair job with some limitations.  I have not found any of the other book printers that offer 

information on page DPI, colour space or paper profiles, other than Momento. 

 

Several of the photo book printers insist on working in old imperial size paper, possibly because their 

systems and printing come from established businesses in the USA, either way, imperial sizes have largely 

gone the way of the dodo and can be confusing for those brought up in the metric era.  Also, be aware 

that in the Covid era times, delivery times for books printed offshore are likely to be extended. 

 

Ultimately, the more you pay the better the quality you will get, so a choice may come down to budget 

considerations over absolute quality. 
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